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Where to Find Help When You Need It 
 
Help from your Division/College’s Computer Consultant 
Some divisions and colleges have computer consultants assigned to them.  You can 
contact these consultants when you need help.  To determine if you have a consultant 
assigned to your division or college, look to: http://rohan.sdsu.edu/~facstaff 
 

Help from the BATS Web Page  
BATS (Baseline Access, Training and Support) is a California State University initiative 
to provide all students, faculty, and staff with "baseline" access to information resources 
via networks, training in the uses of baseline hardware and software systems, and 
ongoing professional and technical support for utilization of computer resources at San 
Diego State University.  You can access the BATS Web Page by pointing your browser 
to: http://rohan.sdsu.edu/~bats/ 
 

Help in the San Diego State University, Faculty Room 
The Faculty Room is staffed Monday through Friday with computing consultants who 
will try to answer your questions.   
Location:    Adams Humanities, 1109 
Phone Number:   x45727 
Semester Hours:   7:30am – 6:00pm Monday -Thursday 

7:30am – 4:30pm Friday 
Semester Intersession:  7:30am – 4:30pm Monday – Friday 

�

Help from the Faculty Computing Help Line 
Phone Number: x41348  E-mail: helpline@mail.sdsu.edu 
Semester Hours:   7:30am – 6:00pm Monday – Thursday 

7:30am – 4:30pm Friday 
Semester Intersession:  7:30am – 4:30pm Monday – Friday 

 
Help from the Staff Computing Help Line 
Phone Number: x40824  E-mail: staffhelp@sdsu.edu 
Semester Hours:   7:30am – 6:00pm Monday – Thursday 

7:30am – 4:30pm Friday 
Semester Intersession:  7:30am – 4:30pm Monday – Friday 
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WHAT IS MICROSOFT EXCEL?  
 
Microsoft Excel is a full-featured spreadsheet program that allows you to organize data, 
complete calculations, make decisions, graph data, and develop professional looking 
reports. 
 
The three major parts of Excel are: 
 
Worksheets – Worksheets allow you to enter, calculate, manipulate, and analyze data 
such as numbers and text. 
 
Charts – Charts pictorially represent data. Excel can draw two-dimensional and three-
dimensional column charts, pie charts and other types of charts. 
 
Databases – Databases manage data. For example, once you enter data onto a worksheet, 
Excel can sort the data, search for specific data, and select data that meets certain criteria. 

 
How Do I Start Excel? 

 
To initially get Excel started, click on the Macintosh HD icon, click on the arrowhead 
next to the Microsoft Office 98 folder and then double click on Microsoft Excel. 
 
You can create an alias that will cause Excel to start automatically when you turn on your 
computer, or you can put a shortcut on the desktop. 
 
Once you have created Excel spreadsheets, you can start Excel by double clicking the 
“Spreadsheet” icon. If you regularly work in a certain spreadsheet, you may want to 
create a shortcut on the Desktop to speed your access to the spreadsheet. 
 

Onscreen Help 
 

There are many different ways to find help when you have questions about the Microsoft 
Excel. The onscreen Help menu is your main source of “how to” information about the 
spreadsheet application. 
 
To view onscreen help, click on Help. The Help menu will pull down. Once the menu is 
displayed, select one of the following tabs: 
 
Show Balloons 
 
Select this option and when you place your cursor somewhere on the screen, a small tip 
window will provide an explanation of the item. 
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Microsoft Word Help 
 
The Office Assistant, an interactive help tool, is activated when you select this option on 
the Standard Toolbar. 
  
Contents & Index 
 

Contents Tab 
 

Here you will find a listing of help topics organized by category. 
 

Index Tab 
 

You can either type in the topic you are looking for or you can scroll through the 
topics to find your answers. 

 
Help in the User’s Manual 
 
You can also use the User’s manual that came with your computer to help you answer 
questions and find solutions to problems. 
 

Help on the Web 
 
Additionally, Microsoft offers Help for “frequently asked questions” at their support 
website located at: 
 
http://www.microsoft.com/support/ 

 
EXPLORING THE WINDOWS  

 
There are two types of windows that appear on your Desktop: the application window 
and the document window.  
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An application window contains the running program. Application windows have menu 
bars. The document window appears inside the application and it does not have menu 
bars. 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Title Bar 

 
The Title Bar shows the name of the application, document, group, directory, or file. If 
more than one window is open, the title bar for the active window (the one in which you 
are working) has a color or intensity different from other title bars.  

 
 
 

Menu Bar 
 

The Menu Bar contains the available menus from which you can choose commands. 
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Tool Bar 
 

The Tool Bar(s) provide you with a quick method of working with various parts of the 
document. Tool bars can be customized and multiple tool bars can be displayed at the 
same time. 

 
 
 
 

Scroll Bar 
 

The Scroll Bars enable you to move through a document or a list when the entire 
document or list does not fit in the windows or the allotted space. 
 
Click the scroll arrows with the mouse to move through the document or to see one line 
at a time. 
 

Boxes 
 
Zoom Box  Clicking the Zoom Box with the mouse enlarges the active 

window so that all its contents are visible (if possible). 
Clicking again returns the window to its original size. 
 

Collapse Box 
 

 Clicking the Collapse Box reduces the window to a single bar. 
 
 

Close Box  The Close Box causes the file to close. If you have not saved 
it recently, you will see a dialog box that asks if you want to 
save the file. 
 

 

Sizing Handle 
 

The Sizing Handle is located at the lower right hand corner of the document window. 
You can change the window size by dragging that handle up and to the left. 

 
Window Border 

 
The Window Border is the outside edge of a window. You can change the window 
location by dragging the border on each side of a window. 
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COMMANDS 
 
Commands are accessed through the Menu Bar. Select a menu item and the commands 
associated with that item are displayed. Clicking on a command causes Excel to apply 
that command to the selected cells. 
 

CREATING A SPREADSHEET 
 
Once you have Excel customized to your satisfaction, you are ready to set up the format 
of the new spreadsheet. You will want to establish the page size and orientation and you 
may want to setup headers and footers for your document. 
 

Page Setup 
 
Select File from the Menu Bar and then choose the Page Setup option. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You can select the desired page orientation on this screen. Click on Options to select the 
desired paper size. The following menu will appear: 
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To change the paper size, click on the down arrowhead in the “Paper” box and scroll 
through the options until the desired paper size is found. Click on the desired paper size 
and the document will be formatted for that sized paper. 
 

WORKING IN THE SPREADSHEET 
 

Workbooks 
 
Workbooks are like notebooks. When Excel first opens, a workbook is opened. Within 
that workbook are worksheets. You create your spreadsheets on the worksheets. 
 
Worksheets are organized into a rectangular grid containing columns (vertical) and rows 
(horizontal). A letter above each column identifies each column and a number on the left 
side of the grid identifies each row. Each worksheet in a workbook has 256 columns and 
65,536 rows. 
 

Moving Around the Worksheet 
 
To select a single cell, place your cursor on the cell and click once with the left mouse 
button. That cell is now the active cell. Note that the column and row headings are 
highlighted. 
 
To select multiple continuous cells first make one cell the active cell. Hold the left mouse 
button down and move the mouse until all the desired cells are highlighted. An 
alternative way to do this is to make one cell the active cell. Hold the Shift key down and 
click on a cell at the end of the continuous range. All cells within that range will be 
highlighted. 
 
To select an entire column or multiple columns, select the column heading(s). To select 
an entire row or multiple rows, select the row heading(s). 
 

Cells 
 
The intersection of a column and a row is a cell. The cell is the basic unit of the 
worksheet and data is entered in cells. A cell is referred to by its unique address, or “cell 
reference”, which is composed of the coordinates of the intersection of a column and a 
row. To identify a cell, specify the column letter first, followed by the row number. For 
example, cell reference D3 refers to the cell located at the intersection of column D and 
row 3. 
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Data can be entered in the active cell. The active cell has a heavy border surrounding the 
cell. In addition, the active cell is listed in the “reference area” immediately above 
column A. 
 
 
 
 
 

Entering Data 
 
Data is entered in cells, and the most common types of data entered are text, numbers and 
formulas. 
 
Text 
 
Excel left justifies text and if the text is longer than the width of the column, Excel 
displays the overflow characters in adjacent cells to the right as long as these adjacent 
columns contain no data. 
 
Numbers 
 
Numbers consist of the digits zero through nine and any one of the following special 
characters: 
 

+ - ( ) , / . $ % E e 
 
If a cell entry contains any other character (including spaces), Excel interprets the entry 
as text and treats it accordingly. 
 
Formulas 
 
One of the reasons Excel is such a valuable tool is because you can assign a formula to a 
cell and Excel will calculate and display the result in the cell. Formulas can be entered in 
uppercase or lowercase, and spaces can be added between the arithmetic operators to 
make the formulas easier to read. 
 
A formula is a sequence of values and cell references in a cell that produces a new value 
from existing values. For instance, Example 1 shows data entered in cells and Example 2 
shows the results. Notice that cell B4 in Example 1 contains a formula that uses the 
existing values in cells B1 and B2. 

Active Cell 
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The equal sign (=) must precede all formulas in a cell. It alerts Excel to the fact that a 
formula is being entered. Valid arithmetic operators are + (addition), - (subtraction), *  
(multiplication), / (division), %  (percentage), and ^  (exponentiation). 
 
When more than one arithmetic operation is involved in a formula, Excel uses the same 
order of operations that algebra follows. Excel will evaluates the operators from left to 
right, and perform the operations in the order shown in the following table. To change the 
order of evaluation, enclose the part of the formula to be calculated first in parentheses. 
 

Operator Description 
: (colon) 

, (comma) 
(single space) 

 
Reference operators 

% Percent 
^ Exponentiation 

* and / Multiplication and division 
+ and – Addition and subtraction 

& Connects two strings of text (concatenation) 
=  <  >  <=  >=  <> Comparison 

 

AutoSum Feature 
 
Excel makes it easy to quickly add a column or row of numbers. The following example 
shows a column of numbers and a "total" needs to be calculated in cell B7. To use the 
AutoSum feature, make B7 the active cell, click on the AutoSum button on the toolbar 
and click on <Enter>. The total will be calculated and the formula bar will show the 
resulting formula. 
 
 
 
 
 
 
 

Example 1 Example 2 
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Fill Handle Feature 
 
The fill handle feature of Excel makes copying a formula in one cell to adjacent cells 
easy. The fill handle is the small rectangular box located in the lower right corner of the 
heavy border around the active cell. 
 

 
 
 
 
 
 
 
 
 
 
 
 

Make the active cell the cell with the formula to be copied, grab the fill handle with the 
mouse pointer and drag it across the cells where the formula is to be copied. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Editing in a Worksheet 
 
Data in a cell can be edited several different ways. If you notice the error while typing the 
data into the cell, use the backspace key to erase the portion of the data that is in error, 
then retype the correct information. 
 
If you notice the error after the data has been entered into the cell, double click the cell to 
enter the “Edit Mode”. Place the cursor at the point of the error and use the backspace 
key to erase the portion of the data that is in error, then retype the correct information. 
 

Fill Handle 

Sum of numbers 
in cells B2, B3, 
B4, B5 and B6 

Sum of numbers
in cells C2, C3, 
C4, C5 and C6 

Sum of numbers 
in cells D2, D3, 
D4, D5 and D6 

Sum of numbers 
in cells E2, E3, 
E4, E5 and E6 
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You can also edit the content of the cell right on the formula bar. Place the cursor 
anywhere on the text to edit the data.  

Working with Rows and Columns 
 
Inserting Rows and Columns 

 
To insert a single row, select a cell in the row immediately below where you want to 
insert the new row. Select the Insert menu and click Rows. 
 
To insert multiple rows, select rows immediately below where you want to insert the new 
rows. Select the same number of rows as you want to insert. Select the Insert menu and 
click Rows. 
 
To insert a single column, select a cell in the column immediately to the right of where 
you want to insert the new column. Select the Insert menu and click Columns. 
 
To insert multiple columns, select columns immediately to the right of where you want to 
insert the new columns. Select the same number of columns as you want to insert. Select 
the Insert menu and click Columns. 
 
Adjusting Row Height and Column Width 

 
To change the height of a single row, drag the boundary below the row heading until the 
row is the height you want. 
 

 
 
 
 
 
 

 
To change the height for multiple rows, select the rows to be changed. Drag a boundary 
below one of the selected rows until the rows are the height you want. When you release 
the mouse button, all the selected rows will be the new height. 
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To change the width of a single column, drag the boundary on the right side of the 
column heading until the column is the width you want. 
 

 
 
 
 
 
 

 
To change the width for multiple columns, select the columns to be changed. Drag a 
boundary on the right side of one of the selected columns until the columns are the width 
you want. When you release the mouse button, all the selected columns will be the new 
width. 
 

 
 
 
 
 
 
 

Formatting Data 
 

Formatting Fonts 
 

You can format characters, words and paragraphs easily by using the formatting toolbar. 
To format a cell, highlight the cell and click on the following buttons as desired: 

 
Font Type and Size 

 
You can select the style of font to be used along with the desired size font size. Click on 
the down arrowhead to see the various font types and sizes that are available. 
 
 
 
 
 
You can also use the following buttons to create a special effect with the font. 

 
Bold Character 

or Text 
Italicized Character 

or Text 
Underlined Character 

or Text 
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Aligning Characters or Text 

 
You can specify how you want the cell alignment by selecting the cell/cells and then 
clicking one of the following buttons: 

 
 

Left Aligned 
 

  
Right Aligned   

Centered  

 

Drag and Drop 
 
To move any portion of the text to a different location, select the text to be moved. Point 
to the selected text, and hold down the mouse button. The drag and drop pointer appears. 
Drag the pointer and the dotted insertion point that appears to the new locations, and then 
release the button. 
 

Relative and Absolute Referencing 
 

By default, all cell references in Excel are relative references. A relative reference is a 
cell reference in a formula that is adjusted when the formula is copied. 
 
For instance, if cell A1 contains the formula “=B3”, then Excel knows that it must look 
one column to the right of column A and two rows down from row 1 to find cell B3’s 
value. If cell A1 is copied to cell A3, Excel will look one column to the right of column 
A and two rows down from row 2 to find the new value, which is now B5. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A B C D E A B C D E
1 =B3 1 =B3
2 2
3 22 3 =B5 22
4 23 4 23
5 24 5 24

A B C D E A B C D E
1 22 1 22
2 2
3 22 3 24 22
4 23 4 23
5 24 5 24

Formula View 

Data View 

Before copy 
command 

After copy 
command 
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An absolute reference is a cell reference in a formula that does not change when copied to 
a new location. To change a relative reference to an absolute reference, insert a “$” 
before the column letter and/or the row number. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

PRINTING 
 

Print Preview 
 
Before you print your document, you may want to look at the document on the screen to 
ensure that your page breaks are where you want them. Excel allows you to see each page 
of the document as it will appear when printed. 
 
To preview your document, click on File on the Menu Bar and select the Print  Preview 
option. 
 
 
 
 
 
 
 
 
 
 
 
 
 

A B C D E A B C D E
1 =$B$3 1 =$B$3

2 2
3 22 3 =$B$3 22
4 23 4 23
5 24 5 24

A B C D E A B C D E
1 22 1 22
2 2
3 22 3 22 22
4 23 4 23
5 24 5 24

Formula View 

Data View 

Before copy 
command 

After copy 
command 
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This view enables you to see what the final document will look like, and it may save you 
from printing pages that are not formatted properly. 
 
To exit the print preview screen click on the Close button. 
 

Printing the Document 
 
When you are ready to print your document, or a part of your document, click on File on 
the Menu Bar and select the Print  option. The following screen will appear: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You will need to tell Excel which pages of your document to print and how many copies 
of each page to print. The system default is “All” which means that if you do nothing 
more than click on the OK  button, Excel will print one copy of your entire document. 
 

Pages 
 
If you want a specific page or pages printed, enter the page numbers in the “From” and 
“To” boxes. 
 

Copies 
 
Once you have told Excel which pages to print, you can choose to have multiple copies 
of the document or pages print. The default is set up to print one copy, so if you only 
want one copy, you do not need to tell Excel about the number of copies. 
 
However, if you want multiple copies, enter the number of copies in the “Copies:” box. 
Once the number of copies is set, click on Print  and Excel will print the desired number 
of copies of the pages selected. 
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SAVING THE DOCUMENT 
 
When you save a document the first time, you need to tell Excel where you want the 
document saved. You will have folders and sub-folders set up, and you will want the 
document saved into a specific folder. To get the document where you want it, you will 
need to be specific in your instructions to the computer. 
 

New File Name 
 
Naming the File 
 
The first time you save a document you will need to name the file and specify where it is 
to be saved. When you are ready to save a document click on File on the Menu Bar and 
select the Save option. You will see the following screen: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Once you determine what you want to call the file, enter that name in the “Save as” 
dialog box. 
 
Specifying the Location 
 
You will tell the computer where to save the file by browsing through your folders until 
you find the folder that is to house the file. To browse, click on the pop up menu at the 
top of the screen. 
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As you move through your folders, the contents of each folder will be displayed in the 
window. You can double click on a folder in the window to see the contents of that 
specific folder. When you do so, that folder becomes the active folder and that folder’s 
name is displayed in the “Save as” box. 
 
 
 
 
 
Once you find the folder that is to house the file, (and the folder’s name is displayed in 
the “Save in” box), click on the “Save” button and your file will be saved in the selected 
folder. 
 
 
 

Same File Name and Location 
 
As you are working on your spreadsheet, you will probably get into the habit of saving 
the document periodically. Once your spreadsheet has initially been saved, you can 
replace the current saved copy with a copy that includes all your changes since the last 
time you saved it. 
 
To save your changed spreadsheet, click on File on the Menu Bar and select the Save 
option. Excel will automatically save your spreadsheet without presenting you with a 
screen asking for a name and location. Excel will use the current name and location as the 
name and location for the current save. 
 

Different File Name and/or Location 
 
To save your spreadsheet with a different file name (in effect you will be making a copy 
of your file and giving it a new name), click on File on the Menu Bar and select the Save 
As option. You will be presented with the same screen you see when you first save a 
spreadsheet. You will be asked to give a new name to the spreadsheet and to specify the 
folder in which the spreadsheet is to be saved. 
 

QUITTING EXCEL 
 
When you are ready to quit Excel, select File from the Menu Bar. Select the Exit  option, 
and if you have not made any changes to your spreadsheet since you last saved it, Excel 
will close your spreadsheet and the Excel application will close. 
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If you have made changes to your spreadsheet since it was last saved, Excel will ask you 
if you really want to exit the program (without saving your changes) or if you want a 
chance to save your changes. You will see the following screen: 
 
 
 
 
 
 
If you do not want to save the changes, select Don’t Save and your document will be 
closed (all changes will be discarded) and Excel will close. 
 
If you want to save your changes, select “Yes” and if your document had been saved 
previously, Excel will save the document with the changes and then it will close the 
document and the Excel program. 
 
If you have not previously saved your document, and you want to save the work you have 
done on the document, Excel will display the “Save As” window. You will be asked to 
provide a name for the document and a location for the document to be saved. 
 

CUSTOMIZING EXCEL OPTIONS 
 
Once you have installed Excel on your computer, you will probably want to set up the 
application in a manner customized to your needs. You can set a variety of options to 
make your work easier. 
 
To customize the application, click on Tools in the Menu Bar and select Preferences. 
Then select one of the tabs and set Excel up in a customized manner. 
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CUSTOMIZING TOOLBARS 
 
Once you have Excel options customized, you can further simplify the use of Excel by 
customizing your toolbars. Toolbars permit you to organize commands in Excel the way 
that you want them so you can find and use them quickly. 
 
To customize a toolbar, select View from the Menu Bar, select the Toolbars option then 
select Customize. 
You can add or delete toolbars from your screen by selecting or de-selecting the toolbar 
while the “Toolbars” tab is showing. 
 
You can remove icons from your toolbars by clicking on the icon and dragging it 
downward and off the toolbar. Once you clear the toolbar, you can release the mouse 
button and the icon will be gone. 
 
You can add icons to the toolbars. Select the category of command you want to add to a 
toolbar. Once the category is selected, scroll through the list of commands until the 
desired command is found. Use the mouse button and drag the command to the desired 
toolbar. Once you close the “Customize” box, the customized toolbars will be available 
for use. 
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Keyboard Shortcuts [Sorted in alpha order by command] 

 
Command Name Modifiers Key 
Bold ; B 
Cancel ; . 
Center Paragraph ; E 
Close or Close All ; W 
Copy ; C 
Copy Text Shift F2 
Cut ; X 
Double Underline ; Shift D 
Help ; / 
Italic ; I 
Justify Paragraph ; J 
Left Align Paragraph ; L 
Open ; O 
Page Break Shift Enter 
Paste ; V 
Print ;� P 
Quit ; Q 
Replace ; H 
Right Align Paragraph ; R 
Save ; S 
Select All ; A 
Underline ; U 

 


